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This document is designed to help get you started using the Interact‐AS program. 
The manual is divided into the following sections: 

 Getting Started (on page 17) 

 Translation (see ʺTranscription and Translationʺ on page 27) 

 Configuration (on page 45) 

 Users (on page 53) 

 Visualize (on page 59) 

 ComposerEditor (on page 61) 

 

In This Chapter 

About Interact‐AS .............................................................................................. 2 
Contact Technical Support................................................................................ 3 
Contact Sales....................................................................................................... 3 
Starting Interact‐AS ........................................................................................... 4 
Typographical Conventions ........................................................................... 15 
 
 

Chapter 1 

Welcome 
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About Interact-AS 
Interact‐AS is an interactive language transcription and translation program that supports 
conversational, continuous free speech. In its basic configuration whatever is spoken is 
transcribed and displayed on the screen, and whatever is written or typed is spoken out 
loud. This allows an individual that is deaf or hard‐of‐hearing, or someone who does not 
have the ability to speak such as a person who has recently had a stroke, to hold 
conversations with someone who does not know sign language. Interact‐AS also gives you 
the option of instantly translating conversations into a second language. If you purchase an 
optional translation module, then whatever is spoken, typed or written in English will be 
instantly translated and displayed and spoken in the desired foreign language; and 
whatever is spoken, written or typed in that second language will be instantly translated 
and shown and spoken in English. In all cases, Interact‐AS generates a complete transcript 
of the conversation that you can save for future reference. Human interpreters, dictionaries, 
or memorization of pre‐recorded phrases are not required. 

How does Interact-AS work? 

Interact‐AS is based on the Interact‐AS product developed by SpeechGear, Inc. SpeechGear 
has developed a line of products that remove language barriers by instantly translating 
conversations and documents; Auditory Sciences, LLC. is a subsidiary of SpeechGear that 
is extending these products to support individuals that are deaf or hard‐of‐hearing or 
otherwise are unable to speak.   

Interact and Interact‐AS use the latest voice recognition, machine translation, and speech 
synthesis technology to remove communication barriers. During voice detection, the 
system uses the surrounding context to correctly identify similar‐sounding words, such as 
ʺrightʺ and ʺwriteʺ.   With continued use, the system adapts to your voice and the 
translation improves even further. The real‐time transcription and translation means that 
errors, such as misspeaking or idiomatic phrases with no meaningful translation, can be 
detected and corrected immediately. You can also rephrase and retranslate right after 
translation has occurred. 

Interact‐AS also has a speech based user interface allowing you to speak commands. This 
enables a complete hands‐free interface that supports situations such as a teacher talking to 
a class room of students, or people speaking in a conference room. 
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How does Interact-AS differ from other language translation 
dictionaries? 

Other comparable voice‐based translators rely on the user speaking a fixed set of phrases, 
each of which corresponds to a pre‐recorded translation. This method works only if you 
donʹt need to translate more than you can memorize and as long as someone else 
anticipates exactly what you need to say. SpeechGear understands that communication is 
often unpredictable and this type of interpretation is not practical for real‐life situations. If 
you want the freedom to literally say any combination of words and transcribe and 
translate what you say in real‐time, Interact‐AS is your solution. 

Interact‐AS supports bi‐directional translation from English to the following languages: 
Spanish, French, German, Italian, Dutch, Mandarin Chinese, Iraqi Arabic, and Modern 
Standard Arabic (MSA). 

How do I find out about related products? 

Interact and Interact‐AS are part of SpeechGearʹs Compadre™ product line. Compadre™ʹs 
wide range of products work together to form a complete solution for all your interactive 
language‐translation needs. Visit http://www.speechgear.com/ 
(http://www.speechgear.com/) to learn more about these products. 
 

Contact Technical Support 
Contact Customer Support if you have questions about how to use this application or if 
you are experiencing technical difficulties. 

Start with the web site. There are FAQ and Release Notes that may have your question 
answered. 

1) Web: http://www.speechgear.com/support.aspx 

2) E‐mail: support@auditorysciences.com 

Contact Sales 
To help us improve our products, we encourage you to provide us with feedback about this 
guide or the product. Please contact us with any questions or comments you may have 
regarding this product. 

Auditory Sciences, LLC. 
1310 Bollenbacher Drive 
Northfield, MN    55057 
E‐mail: info@auditorysciences.com 
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Starting Interact-AS 
In order to use Interact‐AS you need a User Configuration which keeps track of the speech 
recognition settings for yourself (Source) and the settings of the speaker with whom you 
will be talking (Target). When you start Interact‐AS for the first time, the New User Wizard 
launches to help you create these settings. 

You have two options for choosing the Voice Profiles to use for both the Source and Target 
speakers: 

 Create a new profile (recommended), which allows you to select your own preferred 
settings. 

 Use a default profile, which uses preset microphone settings and speech recognition. 

After you specify which profiles to use, anytime you start Interact‐AS later, you can the 
system without going through the setup process again. 

To start Interact-AS 

1) From your desktop, double‐click the Interact icon. 

NOTE: If you do not see the Interact icon on your desktop, click the Start button, point 
to All Programs, point to SpeechGear, and then click Interact. 

The Interact launch window appears. Wait for the program to load.   

2) If this is your first time using Interact, the New User Wizard will launch to help you 
configure voice recognition settings. 

 
Click Next. 
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3) The Name screen appears (Step 2 of 7). 

 
Enter a name. This name will be used to identify your User Configuration. 

NOTE: The name you choose must not contain special characters such as *<>/. Use 
alphanumeric (letters or numbers) characters only. Spaces, hyphens, and underscores 
are acceptable. Choose a name that is not in use for any other User Configuration. 

NOTE: If your version of Interact-AS supports multiple languages you will be better 
able to distinguish between supported languages if the target language is identified in 
the name you provide. Example: John - Spanish 

Click Next. 
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4) The Select Your Languages screen appears (Step 3 of 7). 

 

NOTE: If there is only one available language in the drop‐down list, it will be 
pre‐selected for you. 

a) Click the language drop‐down list, and select the language you will be using 
(English). 

b) From the second language drop‐down list, select the language the other person will 
be speaking. If you have not purchased a translation module, then only ʺEnglishʺ 
will be shown. 

c) Click Next. 
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5) The Select Your Profiles screen appears (Step 4 of 7). 

 

NOTE: A profile refers to the settings Interact‐AS uses to recognize each personʹs voice 
when they speak into the microphone. Interact‐AS includes a default voice profile that 
individuals can use, but we recommend that you create your own custom voice profile. 

Click the voice profile drop‐down list, and select the voice profile that the person who 
is speaking will be using for speech recognition 

Click Add ( ) to create a new voice profile see New English Profile (see ʺNew 
English Voice Profileʺ on page 11). 

a) After your preferred voice profiles are loaded, click Next 

NOTE: You will not be able to click Next until you have made your selection. 
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6) Microphone Setup (Step 5 of 7) 

 
For each new Voice Profile that is created, Interact‐AS will require you to setup the 
microphone input levels. 

b) Click Setup ( ) and follow the directions on the screens. If you need help see 
Appendix B (on page 81). Be patient while the Microphone Setup wizard launches. 

c) Repeat this process for all voice profiles you created. 

d) When you have finished setting up the microphone for both new voice profiles, 
then click Next. 

NOTE: You will not be able to click Next until you have run microphone setup for each 
voice profile you created. 
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7) Voice Profile Training (Step 6 of 7) 

 
Once the microphone levels are setup, Interact‐AS will prompt you to train your Voice 
Profiles to the voices that will be using them. 

e) Click Train ( ) and follow the directions on the screens. If you need help see 
Appendix C (on page 85). Be patient while the training wizard launches. 

f) Repeat this process for all voice profiles you created. 

g) When you have finished training the profile(s), then click Next. 

NOTE: You will not be able to click Next until you have trained each of the voice 
profiles you created. 
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8) The Finished screen appears. 

 
Click Finish. 

The selected profile loads. 

9) The Tip of the Day window appears. You can browse through the available tips, or 
click Close to view the Interact‐AS Translation window. 
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New English Voice Profile 
Continued from step 5 of Starting Interact-AS (on page 4) 

To Create a new English Voice Profile 

h) From the Voice Profile selections screen (step 4 of 7), click Add next to the English 
voice profile drop‐down list. 

 
The Create Profile window appears. 

i) Enter a name for the profile, and click OK. 

 
 

The Audio Setup Wizard –Step 1 of 3 appears. 

j) Position your microphone. 1 
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Follow the onscreen example for how to best position your microphone. Proper 
positioning of the microphone can greatly increase the accuracy of voice 
recognition. If the microphone is out of place, Interact‐AS may not be able to hear 
you clearly and may make more mistakes. Consistent position is also important. 
Make sure that you position the microphone the same way each time you use 
Interact. 

 Headset microphones: Position the microphone about a half‐inch (approximately 
the width of your thumb) from your mouth and a little off to the side. The 
microphone should not touch your mouth, but it can be almost touching your lips. 
If the volume display turns red, try holding the microphone slightly further from 
your mouth. 

If you need to move the microphone out of the way, you can lift the ʺboomʺ up and 
over your head, rather than bending it out of position or removing the headset. 

 Handheld microphones: Although the wizard shows the use of a headset, the same 
guidelines apply when using a handheld microphone, except you should hold the 
microphone about an inch (two fingersʹ‐width) away from your mouth, a little off 
to the side and speak directly into the top of the microphone, not across it. If you 
are using a handheld microphone and it is equipped with an on/off switch, be sure 
to turn on the microphone before proceeding. 

k) Check microphone volume. 

When the Adjust Your Microphone: Volume Check screen appears, click the Start 
Volume Check button, and then read aloud the text shown in the box. When the 
program beeps to indicate it has finished checking the volume, click Next. If you 
need more help with this step, see Appendix B (on page 81). 

NOTE: For best results, wait 3‐5 seconds after you press the button before you start 
to read aloud. 

l) Check audio quality. 

When the Adjust Your Microphone: Quality Check screen appears, click Start 
Quality Check and then read aloud the text shown in the box. When the program 
beeps to indicate it has finished checking the quality, click Next. If you need more 
help with this step, see Appendix B (on page 81). 

NOTE: For best results, wait 3‐5 seconds after you press the button before you start 
to read aloud. 

You will return to the New User Wizard. 

Skip back to step 6 of Starting Interact (see ʺStarting Interact‐ASʺ on page 4) 
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New Second Language Voice Profile 
Continued from step 5 of Starting Interact-AS (on page 4) 

To Create a new Voice Profile for the speaker in the Second language 

m) From the Voice Profile selections screen (step 4 of 7), click Add next to the Target 
(e.g. Spanish) profile drop‐down list. 

 
The Create Profile window appears. 

n) Enter a name for the other speakerʹs profile, and click OK. 

 
The Audio Setup Wizard –Step 1 of 3 appears. 

o) Give the microphone to the other speaker (if sharing a microphone), or tell the other 
speaker to turn on his or her microphone (if using two microphones). 

The Audio Setup Wizard –Step 1 of 3 appears. 

p) Have the other speaker complete the onscreen instructions for positioning his or her 
microphone, checking microphone volume, and checking sound quality. 

q) When finished with set up, tell the speaker to pass the microphone back to you 
(if sharing a microphone). 
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You will return to the New User Wizard. 

Skip back to step 6 of Starting Interact‐AS (see ʺStarting Interact‐ASʺ on page 4) 

 
 

Typographical Conventions 
The following kinds of formatting in the text identify special information. 

Formatting Convention  Type of Information 

To . . . Step‐by‐step procedures. You can follow these 
instructions to complete a specific task. 

NOTE:  Tips or special instructions. 

Special Bold  Denotes a description or a menu option or label. 

Button 

Denotes actiKey combinations for which you must 
press and hold down one key and then press another, 
for example, CTRL+P, or ALT+F4.on. Refers to items 
you must select, such as menu options or command 
buttons. 

Emphasis 

Used to emphasize the importance of a point or for 
variable expressions such as parameters. 

or 

Identifies a dialog box, tab, or other interface item. 

CAPITALS 
Names of keys on the keyboard. for example, SHIFT, 
CTRL, or ALT. 

KEY+KEY 
Key combinations for which you must press and hold 
down one key and then press another, for example, 
CTRL+P, or ALT+F4. 
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If this is your first time using Interact‐AS, use this section to help set up your system so you 
can begin translating. 

 

In This Chapter 

Setting Up Your Microphone ......................................................................... 17 
Troubleshooting Devices ................................................................................ 20 
Keyboard and Digitizer................................................................................... 21 
Tips for Optimal Performance........................................................................ 25 
Overview of Features ...................................................................................... 26 
 
 

Setting Up Your Microphone 
Before you can use Interact‐AS, you need to set up a microphone so Interact‐AS can hear 
your voice. Interact‐AS supports a variety of microphone configurations. Several options 
are described here. 

NOTE: For best results, set up your microphone before you turn on your computer. 

 

Chapter 2 

Getting Started 
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NOTE: An analog adapter is required for computers that do not support a ʺmic inʺ (mini 
jack) port. One end of the adapter is connected to the analog end of the mic cable. The other 
end of the adapter connects to the USB port on the computer. 

Microphone Option 1 (preferred) 

One handheld microphone (shared) with analog (mini‐jack) connector. 

The example below shows one Shure handheld microphone, model SM58S, with a thumb 
switch. A mic cable plugs into the base of the microphone and the other end of the plug 
connects to the ʺmic inʺ (mini jack) port on the computer.   

 

Microphone Option 2 

One handheld microphone and one analog (mini‐jack) headset. 

The example below shows one Shure handheld microphone, model SM58S, with a thumb 
switch. A USB adapter plugs into the base of the microphone and the other end of the plug 
connects to a USB port on the computer. The analog headset is plugged into the ʺmic inʺ 
(mini jack) port on the computer. 
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Microphone Option 3 

Two USB microphones (or one microphone shared between both speakers). 

The example below shows two Shure handheld microphones, model SM58S, which has a 
thumb switch.    A USB adapter plugs into the base of each Shure microphone and the other 
end of the plug connects to a USB port on the computer. Using two microphones requires 
two available USB ports on the computer. 

 

 

Microphone Option 4 

One analog (mini‐jack) headset. 

The example below shows an analog headset plugged into the analog ʺmic inʺ (mini jack) 
port on the computer. 
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Troubleshooting Devices 
It is very important that you have your computer set up to recognize input from your 
microphone and play back sounds through your speakers. You must make these settings in 
the appropriate Control Panel and make sure that the settings in Interact‐AS are the same. 

 Windows XP: Start > Control Panel > Sounds and Audio Devices > Audio tab 

Under Sound playback, select your computerʹs internal sound card. This will ensure 
that sounds get played back through your computerʹs speakers. 

Under Sound recording, choose the type of microphone that you are using. 

 Windows Vista: Start > Control Panel > Classic View > Sound 

On the Playback tab, choose your computerʹs internal speakers. This will ensure that 
sounds get played back through your computerʹs speakers. 

On the Recording tab, choose your microphone input type. 

Note: If you need more help with these Control Panels then open Microsoft Windows 
Help and search for ʺSoundʺ. 

Interact‐AS will use the speaker setting that you made in the Control Panel. It does not 
have any way to change the speakers that you are using.   

There are two places inside Interact‐AS where you can associate the type of microphone 
with a Voice Profile. Both are reached by the Speech Recognition tab of the Configure 
screen. 

10) Each Voice Profile has an Input Device selection listed below the Voice Profile name. 

11) Every time you Set the Microphone Input Levels, the wizard will ask you to choose a 
sound system. 

These both must match the settings that you have made in the Control Panel. 

Unplugging from the PC or switching microphones while using Interact‐AS may cause 
input problems. If a USB microphone accidentally becomes unplugged during use, follow 
these steps to recover an unplugged device. 

To recover an unplugged device 

12) Plug in the microphone again. 

13) Click the Configure button from the Interact‐AS main menu. 

Interact‐AS updates its list of plugged in audio‐input devices when you open the 
Configure screen. 

14) Click the Speech Recognition tab. 

15) Select the appropriate input device from the drop‐down list for the device you want to 
use. 
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16) Go back to the Translate screen. 

17) When asked to save configuration settings, click Yes. 

NOTE:    Occasionally the Speech Recognition will fail to load after this process. If that 
happens, go back to the Configure tab, reselect the appropriate Voice Profile and input 
device, and select the Translate screen again. 
 

Keyboard and Digitizer 
Interact‐AS gives you the option to use the standard keyboard to enter text as an alternative 
to voice recognition. Computers equipped with Microsoft Windows XP or Vista Tablet 
Edition also allow you to enter text using either the standard or digitizer keyboard, or 
handwriting recognition to enter text as an alternative to voice recognition. This is 
particularly useful when users need quiet or privacy, when they are unable to speak for 
any reason, or Interact‐AS has difficulty recognizing their voice or dialect. 

 
 

Adjusting Regional and Language Settings 

To add languages and display the Language Bar for Vista 

18) Click the Start menu, and click Control Panel. 

19) Click Clock, Language, and Region. 

20) From the Regional and Language Options area, click Change Display Language. 

The Regional and Language Options window appears. 

21) From the Keyboard and Languages tab, click Change Keyboards. 

The Text Services and Input Languages window appears. 

22) Click the Language Bar tab. 

23) Select the Docked on the Taskbar option. 

24) Click the General tab. 

25) Click Add. 

26) Select the language(s) to add to the Language Bar, and click OK. 

The default language icon should appear in your desktop taskbar next to your date / 
time information. 

27) Click OK, and close the Control Panel. 
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To add languages and display the Language Bar for XP 

28) Click the Start menu, and click Control Panel. 

29) Double‐click Regional and Language Options. 

The Regional and Language Options screen appears. 

30) On the Languages tab, under Text services and input languages, click Details. 

31) Under Preferences, click Language Bar. 

32) Select the Show the Language bar on the desktop check box. 

33) Click Add. 

34) Select the language(s) to add to the Language Bar, and click OK. 

The default language icon should appear in your desktop taskbar next to your date / 
time information. 

35) Click OK, and close the Control Panel. 

 

To type in non-English characters with the Standard Keyboard 

36) In the text input window, use the mouse to place the cursor in the English recognition 
area, and then use the keyboard to type English characters. 

English text will appear in the English text box as you type. 

37) Translate when ready. 

38) When you are ready to type in another language, change the keyboard mode to another 
language using the Language Bar. 

NOTE: The available languages in the Language Bar will vary. To add more languages, 
use the steps on the previous page (To add languages and display the Language Bar). 

Vista:    XP:   

 

To use the Digitizer Keyboard – Tablet PC Edition Only 

39) Set the keyboard mode to ʺENʺ (English). 
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40) Select the onscreen digitizer keyboard from the Tablet System Tray at the bottom of the 
screen. 

41) Use the mouse to place the cursor in the English text input area, and then use the 
keyboard to type English characters. 

42) Translate when ready. 

43) When you are ready to type in another language, change the keyboard mode to another 
language using the Language Bar. 

 

NOTE: The available languages in the Language Bar will vary. To add more languages, 
use the procedure above (To add languages to the Language Bar). 

44) Select the onscreen digitizer keyboard from the Tablet System Tray at the bottom of the 
screen. 

45) Use the mouse to place the cursor in the target language text input area, and then use 
the keyboard to type non‐English characters. 

 

To use Handwriting Recognition – Tablet PC Edition Only 

NOTE: Handwriting recognition can be used only for English text. 

46) Select the onscreen digitizer input from the Tablet System Tray at the bottom of the 
screen. 

47) Use the mouse to place the cursor in the English text input area, and then use the stylus 
to write English characters. 

Click the Insert button to place the text in the English text input area. 
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Tips for Optimal Performance 
The rest of this guide will help you learn how to perform specific tasks. For general 
performance tips, use the following list as a guideline to help you optimize your experience 
with Interact‐AS and to help prepare foreign speakers for the translation process. 

 Set expectations with the speakers who are unfamiliar with Interact‐AS to know that 
translations may not always be perfect. 

 For best performance, we recommend that ALL speakers use a voice profile that is 
trained to their voice. 

 Use the ʺShow New User Videoʺ voice command to quickly show a foreign speaker 
how to use Interact. You can also access this video by clicking Help > Show 
Introductory Video from the Interact‐AS main menu. 

 Use the Help button if you have questions during translation or setup. 

 Position the microphone not too close and not too far away from your mouth. The 
correct position is one half‐inch from your mouth (approximately the width of your 
thumb). 

 Hold the microphone steady when speaking. 

 Speak clearly and concisely, but not too slowly. 

 Avoid using slang or extraneous words or pauses like ʺumm,ʺ or ʺyou knowʺ. 

 Speak in grammatically correct sentences to produce more accurate translations. Think 
about what you want to say before you say it.   

 Repeat a phrase or sentence in the same utterance (before translating), using different 
words that mean the same thing to clarify a point. This idea of repetition before 
translating can speed up the communication process, especially when asking questions. 

 Vocalize punctuation (commas, periods, question marks) where appropriate to 
produce more accurate translation for longer sentences or multiple sentences in the 
same utterance. For example, at the end of a question, you can say, ʺquestion mark,ʺ 
and ʺ?ʺ will appear in the recognized text area. Although this step is not required, it can 
enhance the quality of the communication. 

 Use NATO alphabet (ʺdeltaʺ = D, ʺechoʺ = E, ʺalphaʺ = A) to spell words or say things 
like license plate letters and numbers. See Appendix A (on page 79). 

 Verify and clear text if recognition is inaccurate BEFORE translating. 

 Use ʺthumbs upʺ or ʺthumbs downʺ hand signals if a translation or recognition is not 
understood by you or the other speaker. 
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Overview of Features 
Interact‐AS contains the following features on the main menu of the Translation window: 

 

Button  Description 

User: 

To use Interact, you must create a User Configuration. You will 
use these settings to tell Interact‐AS which languages to translate, 
which voices to use for synthesis, how to recognize speech, and 
other user preferences. 

Translate: 

After you have created a User Configuration, you can begin 
speaking from the Translate window. When Interact‐AS 
recognizes your voice, the recognized text will appear in the 
appropriate text window. Upon translating the input, the 
translated text will appear on the screen and translated audio will 
play back through your headset or speakers. 

Configure:  The Configure window allows you to adjust the translation 
settings that make up a User Configuration. 

Visualize:  The Visualize window allows you to view a movie or image 
within Interact‐AS to support your spoken message. 

Help: 
The Help menu allows you to launch the Interact‐AS Help file, 
watch a new user introduction video, display the Tip of the Day 
screen, or view the product licensing and version information. 
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The Interact‐AS Translation window allows you to translate words and display the 
resulting text on the screen. Depending on your configuration options, you can 
hear a spoken translation and generate a written log of the translated words and 
even change the spoken translation voice to match a particular gender. If you have 
purchased a translation module, you can choose to have the input text translated 
into a second language. If you have not purchased such a module, then the text in 
both boxes will be displayed in English.   
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Interact‐AS can operate by using voice commands, by clicking buttons, by typing text on 
the screen, and if you have a tablet PC by writing on the screen, or any combination of 
these methods.   

The main interface is accessed by clicking on the ʺTranslateʺ button, which is highlighted in 
the figure below. This interface consists of three main boxes: the top box is owned by the 
person who does not have the ability to speak; the second box is owned by the other 
individual participating in the conversation; and the third box keeps a transcript of your 
conversation that you can save for future reference.   

When you have entered a phrase, you can review it to make sure that is entered correctly. If 
you want to edit your phrase you can do so (weʹll show you how to do that later in this 
section). Once the phrase is correct, then click the Translate button and the text will be 
displayed in the other person's box where it can be read by the other individual and, if 
desired, spoken out loud. 

Chapter 3 

Transcription and Translation 



 

26  Interact User Guide v4.0 Userʹs Guide 
 

In the following figure, the first person has either typed or written, ʺCan I help you?ʺ and 
then clicked the Translate button allowing the second person to hear the phrase spoken out 
loud. The second person has responded by speaking, ʺYes, thanks, Iʹd like to know more 
about this bicycle.ʺ When the second person clicks on the Translate button, that text will 
appear in the top box where the first person can read the phrase and respond 
appropriately. 

If you have purchased a translation module, then when you click Translate whatever you 
enter in English in the top box will be translated and shown in the bottom box in the second 
language; and whatever the second person enters in their native language will be 
translated and shown in the top box in English. 
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NOTE: The following instructions apply to the default user options. To change the default 
settings, see User Options (on page 46). 

To transcribe and translate with Interact-AS 

48) For individuals who cannot speak, you can enter text by typing, or if you have a tablet 
PC, by writing. This is done in the top box of the user interface. To do this, click in the 
top box to activate it. When itʹs activated, it will be highlighted in a green border as is 
shown in the following figure. Then type the text you would like to be translated and 
spoken out loud. Alternatively, if you have a tablet PC, touch the stylus into the box 
and a writing pad will appear where you can enter text by writing directly on the 
computerʹs screen. It is suggested that you use the ʺtoolsʺ feature of the writing pad to 
dock it at the top of your computerʹs screen. 

 
49) The bottom box supports the same ability to enter text as the top box, plus the ability to 

recognize speech. For speech input, first make sure your microphone(s) is plugged in.   

50) To tell Interact‐AS that you want to use speech input, say ʺStart Listening,ʺ or click the 
microphone button on the left side of the recognition area. Speech recognition is 
enabled when you see the volume bars change from gray to color. 

 

NOTE: If you click the button again, you will disable speech recognition. You might 
want to disable recognition during breaks or when passing the microphone to another 
person to avoid picking up unwanted sound. Enable speech recognition when ready to 
speak again. 

If you are using a microphone with an on/off switch, turn the switch on and off as 
needed, while leaving the onscreen button enabled. 

51) Begin speaking into the microphone. As you speak, Interact‐AS will recognize your 
voice and display the words in your text box. 
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NOTE: You can also type the words into the recognition area. 

 
If Interact‐AS did not recognize your words correctly, you can delete the text from the 
screen and try again using any one the following options: 

 Press the Delete button ( ). 

 Say ʺClearʺ to clear the entire block of text. (Works only with English recognition, 
not other languages.). 

52) When you are ready for the second person to see your text, click the Translate button 
in the middle of the screen, or say ʺTranslate.ʺ 

NOTE: The ability to speak command words must be enabled on the Configuration 
screen. Voice Commands currently are available only when English recognition is 
enabled. 
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The translation will appear in the top box and a log of the translation will appear in the 
Transcription Log area. 

 

NOTE: If you want to repeat a spoken translation, you can click the Play button ( ) 
next to the translated text. To automatically play speech synthesis or to change the 
spoken voice, see the Configuration Options. 

 
 

Switching Languages 
If you are using Interact‐AS to support a running conversation with someone who does not 
speak the same language, you may frequently want to switch between language directions 
so that the other person can speak into the microphone and translate back to you. 

To switch language directions 

53) From the Translation window, stop speaking. 

54) Say ʺSwitch Direction,ʺ or click the microphone button to the left of the language box 
to enable speech recognition. 

55) Pass the microphone to the other person (if sharing a microphone), or make sure the 
other personʹs microphone is turned on (if using two microphones). 

 
The new language will appear highlighted. 
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NOTE: The text in the recognition area will already be cleared. If itʹs not, click the 

Delete button ( ). 

56) Prompt the speaker to begin speaking. 

As the person speaks, the target language text should appear in the appropriate box on 
the screen. 

 
57) The person should verify what was said with the thumbs up or thumbs down hand 

signal. 

 Thumbʹs down: Click the Delete ( ) to clear the text and have the speaker try 
it again. 

 Thumbʹs up: The speakerʹs text was recognized accurately. 
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58) When ready to translate the text, click the Translate button in the middle of the screen. 
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The translation will appear in the English language recognition area. A spoken 
translation will be played back and a log of the translation will appear in the 
Transcription area. 

 

NOTE: If you did not hear a spoken translation, you can click the Play button ( ) 
next to the translated text. To automatically play speech synthesis or to change the 
spoken voice, see the Configuration Options. 
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Voice Commands 
Interact‐AS will let you use your voice to do certain tasks in lieu of using the keyboard or 
mouse. These commands are available only in English and only when you are on the 
Translate screen. 

If your system doesnʹt seem to recognize voice commands, make sure the Enable Voice 
Commands option is selected in the User Options window User Options (on page 46). 

To view the command word list 

59) From the Translation window, either click Help > Available Voice Commands, or 
speak: ʺWhat can I say?ʺ A command word list window appears.   

The full list of commands will be available only when the English speech recognition is 
enabled. A subset of this list is available when English speech recognition is disabled. 

You can keep the command list window open while you translate. 

60) To use voice commands during translation, pause for a short time, speak a command 
word and follow again with a short pause.       
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Command Word  Action Taken  Equivalent Onscreen 

Translate  Translates current contents of 
the English recognition area.   

Speak Native  Speaks current contents of the 
English recognition area.   

Clear All  Clears the contents of all text 
boxes.   

Clear Log  Clears the Log box. 
 

Switch Direction 
Switch language directions to 
begin speaking in the target 
language. 

Click in the text area or 
the Microphone button 
of the Inactive 
Language Control. 

Sleep 
Turns off speech recognition. 
(The audio meter & microphone 
button turn to gray.) 

 

Auto Translate  Turns on automatic translation.   

Manual Translate  Turns off automatic translation.   

What Can I Say?  Opens the list of command 
words. 

Help > Available Voice 
Commands 

Exit Interact  Closes the application.   

Enable Log  Turns on the log.   

Disable Log  Turns off the log.   

Maximize Window 
Maximizes the Interact‐AS 
window to fill your entire screen 
area. 

 

Minimize Window  Minimizes the Interact‐AS 
window to your Task Bar.   

Enable Translation 
Synthesis 

Turns on the voice that speaks 
the target language text upon 
translation. 

(none) 
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Command Word  Action Taken  Equivalent Onscreen 

Disable Translation 
Synthesis 

Turns off the voice that speaks 
the target language text upon 
translation. 

(none) 

Enable Native 
Synthesis 

Turns on the voice that speaks 
the native language text upon 
translation. 

(none) 

Disable Native 
Synthesis 

Turns off the voice that speaks 
the native language text upon 
translation. 

(none) 

Restore Window 
Returns a minimized window to 
the size it was last shown 
onscreen. 

Click the application 
from the Task Bar. 

Hide Command 
Window 

Removes this pop‐up window 
from the screen. 

  (On the Available 
Voice Commands 
Window) 

Show User Manual  Opens Interact‐AS Help.  Help > Manual or F1 

Show New User 
Video 

Opens the new user video 
tutorial. 

Help > Show 
Introductory Video 

Enable Continuous 
Repeat 

Turns on the function that 
repeats what you say until there 
is a different input to translate. 

 

 
 

Advanced Dictation Tips 
To Use the Results Box 

Remember to click in the window of the language you want to use before you speak. Start 
talking. As you talk, text displays in the Results box while Interact‐AS figures out what you 
said. The Results box is a small yellow window that appears on‐screen as you dictate. The 
words in the Results box may change as the program considers different interpretations of 
what it heard. 
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To Dictate Punctuation and Line Breaks 

You can dictate punctuation at any time while you are using Interact. 

To Add…  Say… 

,  ʺcommaʺ 

.  ʺperiodʺ 

!  ʺexclamation pointʺ 

?  ʺquestion markʺ 

‐  ʺhyphenʺ 

:  ʺcolonʺ 

;  ʺsemicolonʺ 

 

To Correct Text Using Voice Commands 

There are a number of ways you can correct the misrecognized words or phrases. The 
following technique uses voice commands to open the Correction menu. 

61) Say ʺSelectʺ or ʺCorrect.ʺ 

The Correction menu appears. The Correction menu shows Interactʹs best guess of the 
alternatives to the words you dictated and selected. In the following example, 
Interact‐AS heard the word ʺquickʺ as ʺclinic.ʺ 

62) If an alternative is correct, say ʺChooseʺ and the number of that alternative. In this 
example, you would say ʺChoose 2.ʺ 

 
63) If none of the alternatives is correct, say ʺSpell That,ʺ spell the correct word or words 

into the Spell window, and then click ʺOKʺ In this example, say ʺSpell That q‐u‐i‐c‐k.ʺ 

NOTE: Selecting a large amount of text or an entire transcription, and then saying 
ʺSpell Thatʺ can produce unpredictable results and is not recommended. 
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To Use Select-and-Say® 

You can revise your dictation without correcting it by selecting the text using the ʺSelectʺ 
command and then saying new words to replace the selected text. 

64) Dictate the sentence below: 

Letʹs meet for lunch on Tuesday [period] 

65) Say ʺSelect lunch on Tuesday.ʺ 

The words ʺlunch on Tuesdayʺ should be highlighted on the screen. 

66) Say ʺdinner on Wednesday.ʺ 

These words should replace ʺlunch on Tuesday.ʺ Because ʺTuesdayʺ and ʺWednesdayʺ 
sound completely different, Interact‐AS will know you are not correcting a recognition 
mistake but rather revising your dictated text. 

67) Say ʺSelect period.ʺ If thereʹs more than one period, you can say ʺSelect Againʺ to 
select a different one. 

68) To replace the period or full stop with an exclamation mark, say ʺexclamation mark.ʺ 

NOTE: It is often easier for Interact‐AS to find the matching text if you select a short 
phrase rather than individual words. If you select some words that are already correct, 
just say them again along with the ones you want to change. 
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To Select the same text again 

If the words youʹre trying to select appear more than once on the screen and Interact‐AS 
selects the wrong ones, just say ʺSelect Again.ʺ The program then looks for another 
instance of the same word or words. 

You can also say ʺSelect Againʺ if Interact‐AS selects a word that sounds like the word you 
want, but is not the correct one (for example, ʺtwoʺ instead of ʺtooʺ). 

To Unselect words 

If the wrong text is selected, say ʺUnselect That.ʺ You can also ʺunselectʺ words by moving 
your insertion point by clicking the mouse at another point of your transcription. 

To Select a longer phrase 

You can select a longer phrase by saying ʺSelect [text] Through [text].ʺ For [text], substitute 
the actual word or words at the beginning and the end of the range of wrong words. For 
example, you could correct the selected words in the following sentence: 

With a little practice, who will develop a habit of dictating an unclear, steady voice, and the 
computer will understand you better. 

by saying: 

  ʺSelect who Through unclearʺ or ʺSelect who will Through an unclearʺ 

Then dictate the correct text: 

ʺyou will develop the habit of dictating in a clearʺ 

The final corrected sentence reads: 

With a little practice, you will develop the habit of dictating in a clear, steady voice, and the 
computer will understand you better. 

NOTE: If youʹre correcting more than one word, the words must all be in sequence (next to 
each other). You canʹt use a single command to correct words that are in different parts of 
your transcription. 

To Select a Word or Character 

You can select the current word by saying ʺSelect Word.ʺ To select a character, say ʺSelect 
Next Characterʺ or ʺSelect Previous Character.ʺ You can also select a number of words or 
characters (up to 20). For example, say ʺSelect Previous 2 Words.ʺ 

Say…  Then…  Then… 

ʺSelectʺ  ʺNextʺ  ʺWordʺ 
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Say…  Then…  Then… 

 ʺPreviousʺ  ʺ2…20 Wordsʺ 

 ʺForwardʺ  ʺCharacterʺ 

 ʺBackʺ  ʺ2…20 Charactersʺ 

 ʺLastʺ   

 

To Delete Specific Words 

You can delete text by selecting it and saying ʺDelete That.ʺ You can also say ʺScratch 
Thatʺ to do the same thing. 

To Spell As You Dictate 

With the Spell command in Interact, you can easily spell a word or phrase you want to 
dictate into your transcription. This can be useful if you are dictating a word that is not 
likely to be in the Interact‐AS vocabulary, such as a proprietary term, a proper name, or a 
non‐English word. Say, for example, ʺSpell b‐u‐o‐n space g‐i‐o‐r‐n‐o.ʺ The word you 
spelled appears right in your transcription. 

You must say ʺCapʺ if the word contains a capital letter. For example, say ʺSpell Cap 
R‐u‐m‐p‐e‐l‐s‐t‐i‐l‐s‐k‐i‐nʺ to type ʺRumpelstilskin.ʺ 

If you say ʺSpellʺ by itself, without any letters after it, the Spell window opens. You can 
then speak the letters and Interact‐AS will type them or you can correct any errors in the 
word you spelled. When spelling, you can say numbers and special characters as well as 
letters. For example, to dictate an automobile license plate number, you could say ʺSpell 
y‐h‐m‐6‐0‐9.ʺ Interact‐AS would type ʺyhm609.ʺ Say ʺSpell 
Cap‐m‐a‐c‐Cap‐m‐i‐l‐l‐a‐n‐trademarkʺ to get ʺMacMillan™ʺ in your transcription. 
Spelling a word adds that word to the active vocabulary. Words that contain numbers are 
not added to the vocabulary. 

NOTE: To dictate unusual text such as automobile license plate numbers or product codes, 
you can also switch to Spell mode by saying ʺSwitch To Spell Mode,ʺ and then dictate 
letters. 

You can also access the Spell window when using the ʺSelectʺ or ʺCorrectʺ commands. 
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Using the Transcription Log 
The Log records all translations that Interact‐AS performs. Use the Log Display Options to 
determine what information to track in a log entry. You can save log files and then re‐load 
them when you are ready to do another translation session. All log entries saved will be 
appended to the end of the original log file. 

To start a new transcription log 

69) From the Interact‐AS main menu, click the Configure button. 

70) Verify that the following Log Settings are selected from the User Options tab User 
Options (on page 46). 

 Enable Log 

 Show Timestamp (optional) 

 Show Native Text (optional) 

 Show Translated Text (optional) 

71) Click the Translate button to save the configuration and return to the Translation 
window. 

72) Begin translating. 

When Interact‐AS translates text, a log entry appears in the Transcription Log area. 

 

 

To save a log file 

73) Click the Save Log File button ( ). The Save As window appears. 

74) Enter a name for the log file in the File Name box. 

75) Choose the format in which to save the log file. 

 Plain text files (*.txt): Saves the contents of the log as a tab‐delimited text file. A 
text file is useful if you want to open and/or print the log file using another 
program (for example, Microsoft Excel or Microsoft Word). 

 Compadre Interact‐AS Log (*.cil): Saves the contents of the log as an Interact‐AS 
log file. You can only use files of this type with Interact. 
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 Rich text files (*.rtf): Saves the contents of the log as a tab delimited Rich Text 
Format document that can be opened directly in MS Word or WordPad 

76) Click Save. 

 

To load an existing log file 

77) Click the Load Log File button ( ). 

The Open File window appears. 

78) Select the log file you want to load. 

The file must be in Compadre:Interact™ Log file format (.cil). 

79) Click Open. 

The selected file loads in the Log Content area on the Translation window. As you 
translate, new translations will appear at the end of the text from the loaded file. The 
new translations will be appended to the contents of the originally‐loaded log file when 
you save the file. 

 

To clear the log contents 

Click the Clear Log button ( ). 

The contents of the Log Content area are removed, and a pop‐up window appears to 
ask if you if you want to save the log file. 

 Click no if you want to permanently delete the log content. 

 Click yes if you want to save the log content to a file. 

 

To recover a cleared log 

80) If you want to recover a loaded or previously saved log file, click the Load Log File 

button ( ) to re‐load the same file. 

81) If you saved the log file prior clearing the log, re‐load the newly created log file. 
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Changing Voice Synthesis 
The spoken translation you hear relies on voice synthesis. You can change the gender of the 
voice(s) that you hear using the Configure window. Changing the synthesis allows you to 
accommodate translation scenarios that are gender specific. 

To change voice synthesis 

82) From the Interact‐AS main menu, click the Configure button. 

The Configure window appears. 

83) Click the Voice Synthesis tab. 

84) From the Voice drop‐down list, choose a new voice synthesis for either language. 

85) Click      to hear a sample sentence using the selected voice. 

86) Drag the top slider bar    to adjust the volume of the voice. 

87) Drag the bottom slider bar    to adjust the speed of the voice. 

88) From the Interact‐AS main menu, click the Translate button to save your settings and 
return to the Translate window. 
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The Configure window allows you to adjust translation settings that make up a 
user configuration. Use the New User Wizard to create a new user 
configuration. After you create a user configuration, you can use the Configure 
window to tweak settings and to train a voice profile to make translation more 
accurate. 

 

 

NOTE: If the current User Configuration drop‐down list shows ʺNone,ʺ click the Users 
button from the main menu, and then double‐click a user name before returning to the 
Configure window. 

In This Chapter 

User Options..................................................................................................... 46 
Translation Options ......................................................................................... 48 
Speech Recognition Options........................................................................... 50 
Voice Synthesis Options.................................................................................. 52 
 
 

Chapter 4 

Configuration 
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User Options 
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Command  Description 

Enable Voice 
Commands: 

Allow Interact‐AS to perform functions when you issue a 
spoken command. 

Speak Command 
Confirmations: 

Hear an audible confirmation of enabling or disabling the 
speech recognition. 

Enable Reverse 
Translation: 

Automatically run the initial translation through the MT 
again to provide a translation back from the target 
language into the source language. Note: This does not 
necessarily show exactly what the initial translation is. 

Repeat continuously: 
Repeat what you say until there is different input to 
translate. Use the Repeat Delay box to enter the time (in 
seconds) to wait between repeated translations. 

Enable 
Automatic‐Translate: 

Tell Interact‐AS to translate text when there is a pause or 
break in your dictation. Clear the check box if you want 
Interact‐AS to translate only when you issue a ʺTranslateʺ 
command. Use the Auto‐Translate Delay to set the time (in 
seconds) to determine how long of a pause in your speech 
will trigger an automatic translation of your words. 

Acronym Expansion 

Acronyms, idioms and abbreviations will be expanded into 
more literal text before translation so that the translated text 
means what you really wanted to say. You must enter the 
acronym and its expansion ahead of time in a Composer 
Domain using ComposerEditor. See Acronym Expansion 
(on page 73) 

Enable Log:  Keep a log of all translations that occur. 

Show Native Text:  Show the native text with each log entry. 

Show Translated 
Text:  Show the translated text with each translation log entry. 

Show Timestamp  Display a date and time next to each translation log entry. 

Show Language 
Names: 

Display the associated language name next to each log 
entry. 
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Translation Options 
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Command  Description 

User 
Configuration: 

Lists the current User Configuration whose options you are 
changing 

 
Click on this button to launch ComposerEditor. 

Engine: 

The machine translator (MT) engine is the software that will 
translate from the source to the target language. For most 
language pairs, there will be only one choice. 

The machine translation engines available with Interact‐AS are 
designed to translate the meaning of a source sentence. The 
result may not be grammatically correct but will be 
understandable. 

The translation engines vary by language and may not be able 
to process vocabulary that is unique to your application. Such 
vocabulary could include acronyms or proper nouns. To 
improve accuracy of translations that use such vocabulary, 
Interact‐AS can also use another translation approach that is 
referred to as Translation Memory (TM). 

   

Click to stack MT domains. If you have multiple domains, you 
can choose the order in which the MT provides translation 
suggestions. For example, if you have an ʺInternetʺ domain 
that includes a lot of Internet‐related terms and translations, 
you can stack that on top of the ʺCoreʺ domain. As you are 
translating, the MT will first check the ʺInternetʺ domain for 
matching translations. If nothing is found, it will then check the 
ʺCoreʺ domain. 

Memory: 

The Composer Domain is a separate translation database that 
includes custom phrases and translations specific to your 
needs. For example, if you have a set of phrases that you 
frequently use, you can set up the phrases and their 
corresponding translations in advance and load the Domain 
into Interact. 

Composer Domains are completely customizable and can be 
created to accommodate a variety of translation scenarios and 
language rules. For example, you can create one Domain that 
contains more formal translations and another that contains 
less formal usage. 

Use ComposerEditor (ComposerEditor (on page 61)) to edit 
translation memories. 

 
Click to load or modify Composer Domains you wish to use 
with this configuration. If this button is grayed out, a Domain 
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Command  Description 

is not available for your configuration. Loading or Unloading a 
Domain 

Segmentation: 
If you are using a Composer Domain, you can select the 
segmentation method Interact‐AS will use to break your words 
into recognizable, translatable chunks. 

Confidence: 

If you are using a Composer Domain, you can select the 
minimum confidence level used to determine a potential 
match. When the Confidence is 100%, then the match must be 
perfect, including capitalization and punctuation. However, 
when the Confidence is too low the match might miss small, 
but important, words like ʺnotʺ. 

 
 

Speech Recognition Options 
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Command  Description 

Voice 
Profile:   

The Voice Profile tells Interact‐AS how to recognize your voice 
when you speak into the microphone. You need a Voice Profile 
for each language. For optimal speech recognition, set up and 
train a new Voice Profile for each speaker in the language they 
will be speaking. If you do not want to set up a new profile, you 
can use the Default User (<Your Language>) profiles that are 
loaded with Interact. 

If you do not want to speak to Interact, you can also enter text 
directly into the recognition area on the Translate window. 

 
Add a new Voice Profile. 

 

Remove a selected Voice Profile. You cannot delete the Default 
User for each language; therefore, for those profiles this action 
will instead remove microphone and voice training. 

 
Train a Voice Profile. 

 
Set the microphone levels for a Voice Profile. 

Input 
Device: 

Select your preferred input (microphone) device. Input devices 
are based on what your system recognizes as the default device 
indicated in the Windows audio settings. If any devices are 
plugged into the USB port or if you are using multiple 
microphones, your system should detect these devices. 

Unplugging from the PC or switching microphones while using 
Interact‐AS may cause input problems. If a USB microphone 
accidentally becomes unplugged during use, you may need to 
re‐launch Interact‐AS to make sure the system is listening. 
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Voice Synthesis Options 

 

Command  Description 

Voice: 

Voice synthesis tells Interact‐AS which voice to use when 
playing spoken translations. Select a translation voice 
based on gender that is appropriate to the context of the 
translation environment. 

 
Hear a playback of a sample sentence spoken in the 
selected voice. 

Volume:  Drag the slider from left to right to increase the volume of 
the selected voice. 

Speed:  Drag the slider to speed up or slow down the playback 
rate for the selected voice. 
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To use Interact, you must create a User Configuration. This 
configuration will keep track of the various translation, speech 
recognition voice profiles, and speech synthesis voices for you and 
another speaker. After you create a User Configuration using the 
New User Wizard the first time you start Interact, your settings are 
saved. During subsequent starts of Interact, you can reuse 
previously created configurations to begin translating without 
additional configuration. After you load the user configuration, you 
can continue to train your speech recognition profiles for more 
accurate recognition. 

 

You can save as many User Configurations as needed. For example, 
John can have his own, customized User Configuration with is own 
trained voice profile, while Sarah can also save her own 
configuration settings with her unique voice profile, all on the same 
system running Interact. Each time a user logs on to Interact, he or 
she can change their User Configuration.   

 

In This Chapter 

Creating a New User Configuration ............................................................. 53 
Training a Voice Profile................................................................................... 56 
 
 

Creating a New User Configuration 
You can create a new User Configuration using one of two methods: 

 Use the New User Wizard 

 Create a copy of an existing User Configuration 

 

To create a new user configuration using the New User Wizard 

89) From the Interact‐AS main menu, click the User button. 

 
The User List screen appears. 
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90) Click the Add button to launch the New User Wizard. 

 
91) Follow the onscreen instructions for creating a new English‐speaking user Starting 

Interact‐AS (see ʺStarting Interact‐ASʺ on page 4). 

When finished, the new user configuration will automatically load and the Translation 
window appears. If you go back to the User window, the new User Configuration now 
appears in the list. 

 

To create a copy of a user configuration 

92) From the User window, select an existing User Configuration, and double‐click to load 
it. 

NOTE: You can only copy an active / loaded User Configuration. 

93) Click User > Copy. 

 
The Enter Configuration Name window appears. 
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94) Enter a new name for the copied configuration, and click OK to save the configuration. 

 
The new user is added to the list. 

95) Double‐click the new user, or select the new user and click the “Load” button to begin 
using the configuration. 
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Training a Voice Profile 
Although it is not required, to improve speech recognition and translation performance, we 
recommend that you train a voice profile. This training allows Interact‐AS to more 
accurately recognize your speech. If you choose not to train a personal voice profile, you 
can use the available default voice profile. 

You should plan to spend about 5‐10 minutes to fully set up and train a voice profile for 
each language you are using. It is important that you complete the training process from 
start to finish, so make sure you have enough time to complete the entire training before 
continuing. 

You only need to train a voice profile once. After initial training, you can save the profile 
and reuse it in other User Configurations. 

To Train a Voice Profile 

To train a voice profile, you will need to perform the following steps: 

 Set up audio. You must set up your microphone before training the profile. 

 Train the voice profile. 

Step 1 -  Microphone Setup 

NOTE: You may have already completed microphone setup when you created a new 
User Configuration. If so, you can skip this step and move to Step 2: Train Profile. If 
you are using a different microphone than when you set up your microphone during 
new user creation, you should repeat the microphone setup process again. Continue 
with step 1. 

96) Click the Configure button from the Interact‐AS main menu. 

97) Click the Speech Recognition tab. 

98) From the voice profile drop‐down list, select the profile you want to train. 

 

NOTE: You can also create a new voice profile instead of training an existing voice 

profile by clicking the Add button ( ). 

99) Click  . 

The Audio Setup Wizard –Step 1 of 3 window appears. 
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100) Position your microphone. 2 

Follow the onscreen example for how to best position your microphone. Proper 
positioning of the microphone can greatly increase the accuracy of voice recognition. If 
the microphone is out of place, Interact‐AS may not be able to hear you clearly and may 
make more mistakes. Consistent position is also important. Make sure that you position 
the microphone the same way each time you use Interact. 

 Headset microphones:   

‐ Adjust the headset so that it fits comfortably on your head.   

‐ Move the microphone element to the side of your mouth to avoid noise from 
breathing.   

‐ Make sure that the microphone element is close to your mouth, but not touching it 
(about a thumbʹs width from the side of your mouth).   

‐ Confirm that the front of the microphone points toward your mouth. The front 
may be indicated by a colored dot, the word ʺTalk,ʺ or some other label.   

‐ Position the headset consistently every time you use it. 

NOTE: If you need to move the microphone out of the way, you can lift the ʺboomʺ 
up and over your head, rather than bending it out of position or removing the 
headset. 

 Handheld microphones: Although the wizard graphic shows the use of a headset, 
the same guidelines apply when using a handheld microphone. 

‐ Hold it in a comfortable position. Make sure not to hold it in an awkward, tiring 
position.   

‐ Point the microphone element to the side of or below your mouth to avoid noise 
from breathing. Do not hold the microphone directly in front of your mouth.   

‐ Make sure that the microphone element is about 1 to 3 inches away from your 
mouth. You should keep the microphone distance in this range, but you donʹt have 
to always keep the microphone at exactly the same distance.   

‐ Hold the microphone so that the front/top points toward your mouth. Donʹt talk 
into the side of the microphone.   

‐ Hold the microphone consistently every time you use it. Be careful not to move 
the microphone or your head suddenly.   

‐ Do not use a microphone stand or holder because it will be harder to keep a 
consistent position and the stand may conduct noise.   

101) Check microphone volume. 

When the Adjust Your Microphone: Volume Check screen appears, click the Start 
Volume Check button, and then read aloud the text shown in the box. When the 
program beeps to indicate it has finished checking the volume, click Next. If you need 
more help with this step, see Appendix B (on page 81). 
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102) Check audio quality. 

When the Adjust Your Microphone: Quality Check screen appears, click Start Quality 
Check and then read aloud the text shown in the box. When the program beeps to 
indicate it has finished checking the quality, click Finish. If you need more help with 
this step or if the Quality check screen tells you the sound quality is too low, see 
Appendix B (on page 81). 

The Interact‐AS Configure window reappears. 

 

Step 2 - Train profile 

103) From the Speech Recognition tab, make sure you have selected the voice profile 
that you want to train. 

104) Click  . 

NOTE: If you have already trained the selected voice profile, you can perform 
additional training at any time. 

The General Training screen appears. 

105) Follow the instructions on the screens that follow. If you need more help with this 
step, see    Appendix C (on page 85). 

106) Click the Translate button from the Interact‐AS main menu to begin translating. 
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The media options available with Interact‐AS allow you to open an image, 
video, or blank scribble pad to support your verbal message. The Visualize 
button from the Interact‐AS main menu allows you to open a media file without 
having to leave the Interact‐AS Translation window.   

 

Using Images 
The Visualize button allows you to open an image or video file from within Interact‐AS to 
help supplement your verbal message with a visual. You can create your own files using 
any program you like and save them anywhere on your computer. 

To open an image or video 

107) From the Interact‐AS main menu, click Visualize. 

A File Open window appears with a view into the default directory.   

r) The default directory on XP is C:\Documents and Settings\Application 
Data\Interact\Visualize. 

s) The default directory on Vista is C:\ProgramData\SpeechGear\Visualize. 

108) Locate the image or video file that you want to view, and click Open. 

A new window appears to display the image or video. 

NOTE: You must have Windows Media Player or other media player software to view 
video files. Images open in Microsoft Paint. 
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109) Use the mouse or stylus to draw on or edit the image as needed. You can also save 
the image using the File > Save menu in Microsoft Paint. 

 

To open a blank drawing pad 

110) From the Interact‐AS main menu, click Visualize. 

A File Open window appears with a view into the default directory.   

t) The default directory on XP is C:\Documents and Settings\Application 
Data\Interact\Visualize.   

u) The default directory on Vista is C:\ProgramData\SpeechGear\Visualize. 

111) Select the blank drawing pad.gif file, and then click Open. 

A new Microsoft Paint window appears to display the image. 

112) Use the mouse or stylus to draw on the image. For broader lines, select the paint 
brush option, for narrow lines select the pencil. 
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When you want to edit or create a Translation Memory Domain to be used in the 
Document add‐ins, use the Composer Translation Memory database features in 
ComposerEditor. This tool allows you to customize translation capabilities for individual 
or multi‐user environments. 

A Composer database supports multiple Language Pairs. Within each Language Pair, you 
can add multiple Domains.   

The default translator in Document Workbench is a software program called a Machine 
Translator (MT). The MT is designed to give translations that represent the gist or general 
meaning of a source phrase but those translations might not be grammatically correct. The 
purpose of a Composer Domain is to keep exact translations of often‐used phrases. 
Therefore, if you know the grammatically correct translation of a phrase that you use 
frequently, you can enter both the source and target phrases into a Composer Domain. 
Document Workbench will use the translation from the Composer Domain instead of the one 
generated by the Machine Translator. 

Domains can be either Global, shared by all machine users, or Private, available only to the 
user thatʹs currently logged in. You can select a specific Domain on the Composer tab of the 
Configure screen.    By default, Document Workbench will query the selected Domain first, 
and then query the other Global Domains to attempt to find the closest match for a specific 
translation. 

This section will walk you through the process of using ComposerEditor to select a 
Language Pair, create or edit a new Domain, and add, edit or delete translations within a 
Domain. At the end of this chapter, you will also find instructions for loading the new 
Domain into the Document Workbench application. 
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Main Window 
ComposerEditorʹs Main window contains the following features: 

 

 
 

File menu 

Contains all Composer Domain functions: 

 New ( ): Creates a new Composer Domain. 

 Open... (Ctrl + O  ): Opens an existing Domain in the current database. 

 Close: Closes the current Domain.   

 Close All: Closes all open Domain windows. 

 Recent Documents: Lists the last Domains opened during the current session. 
Choosing a Domain from the Recent Documents list saves loading time. 

 Exit (ALT + F4): Safely closes the ComposerEditor program. 

 
 

Edit menu 

Contains all text edit options: 

 Undo (Ctrl + Z  ): Removes the last editing operation. 

 Redo (Ctrl + Y  ): Redoes the last editing operation. 

 Cut (Ctrl + X  ): Cuts the current selection of text. 

 Copy (Ctrl + C  ): Copies the current selection of text. 

 Paste (Ctrl + V  ): Pastes the last selection of text. 

 Delete (Del): Deletes the current entry in the Domain. 
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Translation Memory menu 

Contains all Domain editing options: 

 New Entry...: Adds a new entry to the Domain 

 Edit Entry...: Opens the Edit Entry dialog box. 

 Delete Entry: Deletes a selected entry. 

 
 

Tools menu 

For more information about Import and Export see Importing and Exporting Composer 
Domains (on page 68). 

 Import...: Provides import functionality; allows you to choose a source file, in TMX or 
Tab Delimited text format, and merge translations from the file with the selected target 
Domain. 

 Export...: Opens a dialog box allowing you to save the active Domain into a tab 
delimited text (.txt) file.   

 
 

Window menu 

Contains window display options: 

 Cascade: Stacks all open Domain windows in a diagonal order. 

 Tile Horizontally: Stacks all open Domain windows top‐to‐bottom. 

 Tile Vertically: Stacks all open Domain windows side‐by‐side. 

 Minimize All: Minimizes all open Domain windows; the main window becomes the 
active window. 

 Maximize All: Maximizes all open Domain windows. 
 

Help menu 

Contains the ComposerEditor About and Help files. 
 

Creating a New Composer Domain 
To connect to a Composer Database 

113) Start ComposerEditor. (Click Start > All Programs > SpeechGear > 
ComposerEditor.) 
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The ComposerEditor Start window appears. 

114) In the Start dialog, select SpeechGear Translation Memory. 

115) Click on the New or Open button   

The Edit window appears. 

All Global and Private Composer Domains which are available to the logged in user 
will be listed in the Domain window. 

 

To add a Language Pair to the Database 

116) Connect to your Composer database. 

The Edit window appears. 

 
117) Click Add Language Pair. 

The Select Language Pair window appears. 

 
118) Select the Source and Target languages to use in the new Language Pair, and then 

click OK. 
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A confirmation window appears. 

119) Click Yes to create the new Language Pair in the connected database. 

The Language Pair is added to the list with a default (Global)General Domain. 

NOTE: You may have to scroll to find the Language Pair in the list. 

 

To Add a Domain to a Language Pair 

120) Connect to your Composer database. 

 
121) Select the Language Pair you want to add a Domain to. 

By default, ComposerEditor will create a Private Domain. If you want to add a Global 
Domain then expand the Language Pair and select the Global User under the 
Language Pair 

122) Click Add Domain To User. 

NOTE: If you have previously removed the Global\General domain you will be asked 
here if you’d like to create a new one. 
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The Add Domain Name window appears. 

 
123) Enter a name and a description for the Domain, and then click OK. 

A confirmation window appears. 

124) Click Yes to create the new Domain. 

The Domain is added to the selected Language Pair. 

 

 

To remove a Domain 

125) Connect to your Composer database. 

126) Right‐click a Domain name, and then click Remove Domain. 

A confirmation window appears. 

127) Click Yes. 

NOTE: If the Domain was successfully deleted, you will no longer see it in the database 
list. 
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To remove a Language Pair 

128) Connect to your Composer database. 

129) Right‐click a Language Pair name, and then click Remove Language. 

A confirmation window appears. 

130) Click Yes. 

The selected language and all related Domains will be removed from the database list. 
However, if any entries were added by another user (besides the Global and current 
user), the delete operation will abort.   

 

Opening a Composer Domain 
To open a Composer Domain 

131) Launch ComposerEditor and open SpeechGear Translation Memory   

The Edit window will appear 

 
132) Click the ʺ+ʺ next to the Language Pair to expose the users Global and Private. 

Select the Domain that you want to open. 

133) Click on the ʺ+ʺ next to either the Global or Private user to expose the domains 
within each.   

The selected Domain will open in a new window. 
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Importing and Exporting Composer Domains 
ComposerEditor allows you to import translations from a file into a Composer Domain or 
export translations from a Domain into a file. 

Files to be imported from must be in Translation Memory eXchange (TMX) format or tab 
delimited text files. TMX is a file format based on XML that is a standard of the 
Localization Industry Standards Association (LISA). Exporting data will result in the 
creation of a tab delimited text file.   

NOTE: Importing of a file cannot be undone. 

To import into a Composer database Domain 

134) Create a TMX file or an existing tab delimited text file that has the translations you 
want to import. 

135) Create a new Domain or open an existing Domain into which to import the terms. 

136) From the ComposerEditor Main window, click Tools > Import.... 
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The Import Translation Memory window appears. 

 
137) Select the file that you want to import. 

Click Open. 

 

To export a Composer Domain 

138) Open a Composer Domain. 

139) From the Tools menu, click Export. 

140) Enter a name for the new file, and then click OK. 

The file is exported into a new tab delimited text (.txt) file.   
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Editing Composer Domains 
ComposerEditor uses right‐click commands to display all editing menus. When working 
with Composer Domains, you have the following edit commands: 

 New Record 

 Edit Record 

 Delete Record 

 Save a Domain 

To Add a New Record 

141) Open the Domain you want to edit. 

142) Right‐click anywhere in the Domain window, and then click New Record. 

 
The New Domain Entry window appears. 

 
143) Enter the source text, target, and notes. 

144) Click OK. 

The record is added in alphabetical order to the Domain. 
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To Edit a Record 

145) Open the Domain you want to edit. 

146) Double‐Click on the record you want to edit   

Or 

Right‐click on the record you want to edit, and then select Edit Record. 

The Edit Domain Entry window appears. 

147) Edit the source text, target, and notes. 

148) Click OK. 

 

To Delete a Record 

When you delete a record, it is permanently removed from the Domain. If you are working 
in a Global Domain in a multi‐user environment, deleting a record will remove it for all 
users who are working with the Global Domain. 

149) Open the Domain you want to edit. 

150) Right‐click on the record you want to delete, and then click Delete Record. 

ComposerEditor removes the record from the list.   

Note: No confirmation box will appear but there is an Undo command under the Edit 
menu. 

 

To Save a Domain 

When working with Composer Domains connected to a shared database, changes will 
automatically be written to the database as you work. If you make an error during editing, 
you can undo the last editing operation from the Edit > Undo menu. 

When you are finished editing entries, close the Domain window to close the connection to 
the database. 
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Acronym Expansion 
Acronym Expansion is a feature of Document Workbench that assists in getting the correct 
translation of acronyms, idioms, abbreviations and technical phrases. For example, if you 
dictated ʺWeʹre like two peas in a pod.ʺ into the English recognition area on the Translate 
screen and clicked the Translate button, the Target text might be talking about vegetables. 

In order to get the correct translation of an idiom, Document Workbench has a mechanism to 
substitute the idiom with another phrase in the same language that means the same but 
uses a more literal phrase. Therefore, the literal phrase can be translated instead of the 
words of the idiom. 

For example: 

 ʺpet projectʺ becomes ʺfavorite projectʺ 

 ʺWeʹre like two peas in a pod.ʺ becomes ʺWeʹre very similar.ʺ 

 ʺWhen pigs flyʺ becomes ʺNeverʺ 

This can be very helpful if you are using Document Workbench to communicate for your job 
and your industry regularly uses abbreviations. You can see that itʹs important to create 
your own list because different industries may use the same acronym for different terms. 

 ʺAMTʺ becomes ʺAlternative Minimum Taxʺ 

 ʺNSFʺ becomes ʺNot Sufficient Fundsʺ 

 ʺPITIʺ becomes ʺPrinciple, Interest, Taxes and Insuranceʺ 

 

This feature is enabled by checking the box labeled ʺExpand Acronymsʺ on the Tools menu 
on the Workbench main menu bar. See User Options (on page 46) 

You create this list of idioms and literal phrases in ComposerEditor by using the 
<language> to <language>\General Composer Domain.   

Note: This feature can be used for any language, for example Spanish to Spanish, but only 
the General Domain is currently supported. 

To Add or Edit entries in Acronym Expansion 

151) In ComposerEditor, open the English to English\General Domain. 
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152) Then add or edit terms that the English speakers might use in conversation. 
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If the Acronym Expansion capability is enabled in Document Workbench, every time you 
click the Translate button on the Translate screen, the text that is in the English recognition 
area gets compared with each of the Source entries in the English to English\General 
Domain. If an exact match is found, that phrase is replaced with the Target phrase before the 
English text is translated.   

Therefore, you will still see the Source phrase in the English recognition area on the 
Translate screen, but the text that is translated will contain the Target phrase from the 
Domain. If logging is enabled, the translated text with included expansion will be saved to 
the log. 

To reiterate, even though the examples are in English, this feature is available in other 
languages, too. 

Note: Acronym Expansion Segmentation is independent of Translation Segmentation. It 
checks for matches in this order: 

1.    Full sentence matches 

2.    2‐word matches, in any segments where full sentence matches were not found 

3.    1‐word matches, in any segments that were not expanded by full sentence or 2‐word 
matches 
 

Loading or Unloading a Domain 
To Load or Unload a Domain 

153) Within Interact, click the Configure button, and then the Composer tab 

154) Click the Select Translation Memory Domain ( ) button 

The Select Domain window appears. 
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155) There are three options on this window: 

 Click Clear to unload any Composer Domains from   

 Select the Composer Domain that you want to use and then click OK 

The selected Composer Domain will load and you can use it in your translating 

 Click Cancel to exit the window with no change 

Note: Composer Domain queries: 

‐ Will query the selected Domain first (either Private or Global) followed by all the Global 
Domains. 

‐ Currently does not provide the option of selecting multiple Private Domains 
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enable: (turn on) 

disable: (turn off) 

log: records all translations that Interact‐AS performs. The Log Content area will display the 
translations. 

machine translator (MT) : a software program, sometimes called an engine, to translate text 
from one language to another. 

training: refers to the process of speaking a set of predetermined phrases in your normal, natural 
voice to help the speech recognition engine more accurately recognize your voice. 

translation memory (TM): a collection of phrases and their translations. TMs are used to 
supplement an MT by providing acronym expansions or phrase translations specific to an 
organization that an MT alone might not be able to translate correctly. 

user configuration: refers to the settings used for an Interact‐AS user. These settings include 
speech recognition engine voice profiles, voice synthesis voices, as well as options set in the 
Configure window. 

voice profile: stores microphone settings and speech recognition settings to assist you in 
translating your voice to text. 

voice synthesis: the artificial production of human speech. Speech synthesis systems are often 
called text‐to‐speech (TTS) systems in reference to their ability to convert text into speech. 

 

Glossary 
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NATO Alphabet 

LETTERS 

 A ‐ ALFA 

 B ‐ BRAVO 

 C ‐ CHARLIE 

 D ‐ DELTA 

 E ‐ ECHO 

 F ‐ FOXTROT 

 G ‐ GOLF 

 H ‐ HOTEL 

 I ‐ INDIA 

 J ‐ JULIETT 

 K ‐ KILO 

 L ‐ LIMA 

 M ‐ MIKE 

 N ‐ NOVEMBER 

 O ‐ OSCAR 

 P ‐ PAPA 

 Q ‐ QUEBEC 

 R ‐ ROMEO 

 S ‐ SIERRA 

 T ‐ TANGO 

 U ‐ UNIFORM 

 V ‐ VICTOR 

 W ‐WHISKEY 

 X ‐ XRAY 

 Y ‐ YANKEE 

 Z ‐ ZULU 
 

Appendix A 
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NOTE: The following steps are continued from sections New English Profile (see ʺNew English 
Voice Profileʺ on page 11) and Training a Voice Profile (on page 56). 

Setting up Microphone Audio 
156) The Audio Setup Wizard (Step 1 of 3) screen appears. 

 Position the microphone about a half‐inch (approximately the width of your thumb) 
from your mouth and a little off to the side. The microphone should not touch your 
mouth, but it can be almost touching your lips. 

 If you need to move the microphone out of the way, you can lift the ʺboomʺ up and over 
your head, rather than bending it out of position or removing the headset. 

157) Click Next. 

 
The Audio Setup Wizard (Step 2 of 3) screen appears. 

Appendix B 
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158) The computer needs you to read some text aloud to set the input volume. Click the Start 
Volume Check button to begin. 

 
The text becomes readable. 

159) Read the text in the box. As you read, the volume bar levels will fluctuate. 

 
When the system has had enough time to do the check, you will hear a beep. The Next 
button will become available. 

NOTE: If the volume check was not successful, you will receive a message to indicate that 
either the sound level was too high, too low, or that your microphone is not successfully 
connected. In the error message box, click the Help button to launch Dragon 
NaturallySpeaking Help. It will include recommendations for adjusting your equipment. 
When you are ready, start the volume check again. 

160) When you have passed the volume check, click Next. 

The Audio Setup Wizard (Step 3 of 3) screen appears. 
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161) The computer needs you to read some text aloud to test the quality of audio input on 
your system. Click the Start Quality Check button to begin. 

 
The text becomes readable. 

162) Read the text in the box. 

As you read, the quality bar levels will fluctuate. Speak in your natural tone of voice. 

 
When the system has had enough time to do the check, you will hear a beep. The results of 
your speech‐noise ratio and audio quality check will appear. 

NOTE: If the audio quality results in a FAILURE, an error message will appear indicating 
that the quality of the sound system is unacceptable. In the error message box, click the Help 
button to launch Dragon NaturallySpeaking Help. It will include recommendations for 
adjusting your equipment. When you are ready go back to the Volume Check, reposition 
your microphone and do the volume & quality checks again.   

Note: You should also click Play to hear what the system hears. If you have difficulty 
understanding what is said, the system will too.   

Tip: After clicking the Start Volume Check or Start Quality Check buttons wait 3‐4 seconds 
before you start reading the text.    This gives the computer time to adjust to the background 
noise. 
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163) When you have passed the quality check, click Finish. 
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Training a Voice Profile 

NOTE: The following steps are continued from section Training a Voice Profile (on page 56). If 
youʹve already trained the selected voice profile, you can perform additional training at any 
time. 

The General Training screen appears 

164) Click Go and then read the onscreen sentence aloud. 

 
 To advance through the first two screens, you must say the sentences without pausing. 

 When the words change color, it means the computer has heard and recognized them. If 
you keep reading the same words, and the computer still doesnʹt get it, just click Skip. 
Otherwise, click Next to continue. As you read, more text will appear. 

After you have finished the first two screens, the Select Text window appears. 

Appendix C 
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165) Choose a text to read aloud and click OK. 

 
The selected text appears in the window. 

 
166) Start reading. 

 Itʹs okay to pause in the middle of a sentence. To take breaks while youʹre training the 
program, click Pause. 

 Donʹt worry if you make mistakes or laugh. You should try to read exactly what you see 
on the screen, but itʹs okay if you read something incorrectly. The computer will either 
ignore the mistake or display the yellow arrow to show you where to begin reading the 
text again. 
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 The progress bar shows how much text you have left to dictate. As you speak, the words 
that you have already spoken will turn gray. 

 
When youʹve read enough, the Dragon NaturallySpeaking Adaptation message appears. 

167) Click OK to return to the Interact‐AS Configuration window. 
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